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Brief Description of ztrAck© 

 
� ztrAck© keeps a database on all student discipline ‘incidents’ and 

automatically compiles disciplinary history reports, letters to parents (optional 
feature), statistical reports and many other features.  This information is 
extremely useful for parent teacher interviews, policy development, 
school accountability and annual reports. 

� Generates letters to parents based on incident type and response. 
� Accentuate the positive.  ztrAck© will keep track of the good things that 

students do as well!  It produces achievement and leadership summaries and 
award certificates.  Positive reinforcement for classroom work, sporting and 
extra-curricula excellence. 
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Multi – User version  

Installing Z Track on your network 
 

1. Install Filemaker Pro 7 or later ® on to all of the terminals/work stations 
that you want to have access to the Z Track software. 

2. Create a new folder called ztrack in a suitable location/drive on your 
server  e.g.    f:/staff Files/ztrack. IMPORTANT: set this file to be shared 
and make sure that all intended users have FULL read/write permissions 
to this folder. 

3. Insert the CD and install to the location specified in step 2.  
e.g.  f:/staff files/Z Track 

4. Use install c.d. to install to network location OR Select ALL 8 files after 
copying then right click > properties to turn off the read-only check box.  

5. Check that each of the 8 files listed below is in the folder. 
6. Create two folders at this location – one called student photos and the 

other staff photos. 
 

1. incident.fp7 (this is the primary file) 
2. zBarhoriz.fp7 
3. action descriptions.fp7 
4. incident descriptions.fp7 
5. letters.fp7 
6. photos.fp7 
7. student.fp7 
8. teacher.fp7 

 

7. IMPORTANT! If you are not using Filmaker ® server, set a scheduled 

task on your server to open the file called incident.fp7 (master file) each 
day. This ensures that the database is hosted by the server, not a slower 
‘guest’ machine.  **See (about sharing files on a network) for more detail 
on installation options. 

 
8. The installation file contains the Filemaker ® plug-in shown below. Copy 

these into the Filemaker® extensions folder on the server version of 
Filemaker® and ALL work station versions. E.g. C:\Program 
Files\FileMaker\Filemaker Pro  8.5\extensions\ 
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9. Open the file called incident on the server. From the main menu > Utilities 
> Set Network Path. Enter the network path in the format specified in the 
pop-up dialog box . IMPORTANT NOTE: Filemaker ® uses forward slashes 
as shown. 
Path format:  filewin://computerName/shareName/ztrAck/   
Note: computer name can be the IP address. 

10.  To set up your school data and categories etc consult page 5 of the 
manual (on the c.d.) 
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Starting the Program first time (multi –user version) 

1. Open Filemaker on local/client machine 

2. Select File>Open Remote then enter the server I.P. address then the 
filename incident.fp7. in the format shown in the dialog box (make sure to 
click Add so that you only have to enter this information on the first 

opening) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click Add.. after you have specified the address. 
4. Enter the appropriate details in the Edit Favorite Host dialog and clicking 

Save. 
5. After this initial setup the 

user can access ztrAck by  

• Opening Filemaker Pro 
• File > Open Remote 
• Selecting the server you 

entered at step 2 above 
and then clicking the file 
incident.fp7 

 
Call Don on 51455307  mob: 
0438 493 168  or email 
don@zdata.com.au with any 
problems. 
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1. Site Map (go to site map) 

2. Incident Files – opens the discipline, 

welfare and achievement incidents 
database so that records can be 

created and edited. 
3. Enrolment Data – opens the student 

enrolment records so that records can 

be created, edited or imported. 
4. Staff Files – opens the staff records 

so that records can be created, edited 
or imported 

5. Utilities - opens the utilities database 
so that incident types, actions and 

statistics can be viewed or edited.  
 

Starting the Program(single –user version) 

1. To launch ztrAck©, double click on this icon (or similar) on your desktop. 

fig. 1 -  Desktop icon 
 

2. The site map appears, see fig. 2 below. 
 

 
fig. 2 – The Site map 

 

 

 

 

 

 

Setting up the database 

Before using the database to record discipline and achievement incidents the set 
up tasks should be completed.   The section immediately after this table explains 
how to complete each task.  It should take about 30 minutes to set up the 
database correctly. Come back to this checklist table and tick off each set up task 
as you go. 
 

SET UP CHECK LIST TABLE 1 
Set up Task Where? Reference  ���� Tick completed 

School Details Utilities > School Details PAGE 7  

Creating Incident descriptions* Utilities > Incident Descriptions PAGE 7  

Creating Action Descriptions Utilities > Action Descriptions PAGE 8 - 10  

Importing student/ parent details Main Menu>Enrolment Data  PAGE 14  

Importing staff details Utilities > Staff File PAGE 17  

 

School Details  
From the site map, click the ‘Utilities’ button and then choose ‘School Details’.  
Enter your school details.  These are the details that appear on form letters and 
in student records 
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Creating Discipline/Welfare/Incident Descriptions 

The database can be customized to suit the needs of your school. Most schools 
have incident descriptions for things like unapproved absence, not following 
instructions, bullying and rudeness. The database is already populated with 
commonly used categories, check these then add some of your own. 

How to add new Incident Descriptions 
1. From the Utilities menu select Incident Descriptions 
2. Add a new category by selecting the New button. 
3. Select an action category (Discipline, Welfare or Achievement) 
4. Enter an incident type e.g. smoking,    

*ZENITH DATA can set up your categories for you before you receive your 
database.  
 
These categories appear in the records themselves and on all statistical reports. 
(see fig. 3 below) 
 

 
fig.3  - Sample Incident Descriptions 

 

How to edit Incident Descriptions when in a student record  

You may from time to time decide you want to make changes to the incident 
descriptions while you are editing a student’s incident record. To add an incident 
description open Utilities > Incident Descriptions and enter the new incident 
type.  
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Creating Action Descriptions 

Once the incident descriptions have been determined, the next step is to decide 
on the ‘actions’ (responses by the school) that will apply to each incident type.  
Some actions may apply to several incident types.  After school detention for 
example could be an action in response to bullying, lateness or smoking.  An 
action in response to the discipline incident OVERDUE WORK might be OVERDUE 
WORK LETTER SENT HOME.  Each of the incident descriptions you decided on 
(in the previous step on page 7) should have at least one appropriate ‘action’ in 
response to it.  A sample of one school’s incident descriptions and actions is 
shown below in table 1.  
 
 
 
Table 1 - Examples of incident descriptions and actions 

Discipline Category Action 

overdue work Overdue work letter sent home 

bullying Counseled on bullying, letter sent home 

late to class Lunchtime detention 

swearing Lunchtime detention 

 
How to add new Action Descriptions 

1. From the Utilities menu select Action Descriptions 
2. Add a new category by selecting the New button. 
3. Select an action category (Discipline, Welfare or Achievement) 
4. Enter an action e.g. detention    

 
*ZENITH DATA can set up your categories for you before you receive your 
database.  
 
DO NOT CHANGE THE ACTIONS NUMBERED 1 TO 14 as they are used in preset 
form letters. See Form Letters page 25 for details 
These categories appear in the records themselves and on all statistical reports. 
(see fig. 5 below) 
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fig. 5 - Sample Action Descriptions 

 

How to edit Action Descriptions when in a student record  
You may from time to time decide you want to make changes to the action 
descriptions while you are editing a student’s incident record. To add an incident 
description open Utilities > Action Descriptions and enter the new action type.  
 
 
 

Detention Reports  
 

Entering detention times and location 
When detention is selected as the response to a discipline incident a dialogue 
box will appear asking for a time and location for the detention. Complete the 
required details and click OK. (see below) 
 

 

 Fig 8 Entering Detention time and location 
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Printing a list of scheduled detentions  
 

 

 
 
 
 
 
   
1. Click on the Reports icon in any screen. 
2. Click on the Detention icon. 
3. Specify a date range for your report. 
4. Select View or Print. 
 
 
The report shows past and future detentions according to the action dates 
specified in when the records were created. 
IMPORTANT: Print a list of students to attend the detention prior to the scheduled 
time.  The duty teacher can use this list to mark the role of students attending.  
The duty teacher should place a tick in the TICK IF PRESENT box and then hand 
the completed report to the teacher responsible for maintaining the database.   
This teacher then records the students that attended the detention in the 
database. See below ‘Checking attendance at scheduled detentions’. 
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Checking attendance at scheduled detentions 
 

 

 

 
 
 
 
 
 
1. From the Incident Description or Reports screen. Click on the green tick 

labeled Update Detentions. 
2. A list of all detentions recorded as not completed appears. Click the radio 

button ‘Yes’ for any detentions you wish to record as completed. 

 

 
 

Changing detention Times 

1. Find the record in which you want to change the detention time. 
2. Click on the clock icon and enter the new details.  

 
 

 

 

Update 
Detentions 
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Suspensions  
 

Specifying Suspension Days 
 
          

 

 
 

1. Click on the Reports icon in any screen. 
2. Click on the Suspension icon. 
3. Specify the number of days for the suspension. 

 
To change the suspension dates change the action dates 1 and 2 in the relevant 
record. 
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The Student File  - Importing Student and Parent Details  
 

Importing Photos 
 

• Photos can only be imported into the database en masse if the photo file 
names contain the student’s unique id code and this code is more than 3 
characters.  

• If the photo file name does not include the student’s unique id code then 
student photos can be copied and pasted individually into the student 
photo field in the enrolment data file. 

 
IMPORTANT NOTE ON IMPORTING PHOTOS: 
After installing the ztrAck© software copy and paste the student photos (usually 
on a c.d.) into the folder named student photos at the root level of the ztrAck 
file. This is where the ztrAck© will ‘look’ for the photos when you are importing 
student details. 
 
For non-network installations - Copy and paste photos to this location:   
C:\Program Files\Ztrack Runtime 0306\student photos 
 
Note: If ztrAck© is installed on a network drive copy and paste the photos to the 
folder called student photos in the folder called Ztrack (or similar). The student 
photos folder must be at the same lvel as the Filemaker Pro® files. 
 
E.g.    e:\Ztrack Runtime 0306\student photos 
 
The student details can be imported from just about any enrolment package.   
 
Obtaining Student Data from the source database (enrolment package). 
Any good database program will provide the facility to export data from it.  When 
exporting data for use in the ztrAck ©, save the data in tab separated text 
format .tab or comma separated values .csv (these are the most common 
formats, but many others are supported). 
 
Importing Data from CASES 21(Victorian schools only) 
ZENITH DATA recommends that we install the student details data and do a 
system check when the database is set up.  The following instructions are only 
intended as a guide for someone already conversant with the database utilities 
query tool in CASES 21.  It is not advisable to attempt this data export without 
knowledge of CASES 21.  Most schools opt for Zenith Data to install the CASES 
21 data for them. 
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Extracting the student information data from CASES21 
1. Have a 3½-inch floppy disk, memory stick or c.d. or similar ready for the data 

export. 
2. Use the Export from the Database function in the Utilities feature of CASES21 

in order to extract data for use in the Z-Track software. 
 
 

DATA TYPE CASES 21 TABLE 

Student info ST 

Addresses UM 

Families (parent/guardian) DF 

Staff SF 

 
TABLE 2 - Student information fields to export from cases21 or other student 
database 
 
Field Name in CASES 21 Field Name in ztrAck©(Enrolment Data file) 

ST.STKEY Student ID 

ST.SURNAME Surname 

ST.FIRST_NAME First name 

ST.PREF_NAME Preferred Name 

ST.GENDER Gender 

ST.BIRTH_DATE Birthdate stud 

ST.HOME_GROUP Grade Form 

ST.SCHOOL_YEAR Student Year 

UM.ADDRESS01 Parent 1 Street 

UM.ADDRESS02 Parent 1 City 

UM.POSTCODE Parent 1 Postcode 

UM.TELEPHONE Parent 1 Phone Day 

DF.TITLE_A Parent 1 Title 

DF.NAME_A Parent 1 Name 

DF.SURNAME_A Parent 1 Street  Surname 

 Parent 1 Phone Mobile 

 Parent 1 Phone Work 

DF.TITLE_B Parent 2 Name 

DF.NAME_B Parent 2 Name 

DF.SURNAME_B Parent 2 Surname 

 Parent 2 Phone Mobile 

 Parent 2 Phone Work 
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Importing the student information data into the ztrAck© 
The student data that you saved to disk in the previous step can now be 
imported in to the Z Track database.  
 
 
 
 
 
  
Follow these steps: 
 

1. From the main screen click ‘Enrolment Data’ and then select the Import 
button. 

2. A delete current records message appears. Delete these records if you no 
longer require them. This will not delete the incident records only the 
student enrolment details. 

3. Choose the import option from the dialogue box below.  
• If you do not have student photos to import click DATA.  

• If you have student photos and enrolment data choose BOTH. 
•  If you just wish to update photos choose PHOTOS. 

 
 
 
 
 
 
 
 

4. Click OK and Select the location of your enrolment data (on the storage 
media you saved the data to when you exported form your enrolment 
software e.g. CASES 21) – see  Extracting the student information data 
from CASES21 
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5. Select All Files in the ‘files of type’ box 
6. Click the student data file you exported earlier to disk and click ‘open’ in 

the dialogue box. 
7. The import filed mapping dialogue box appears (see fig. 10 below) 

 

 
fig. 10 – the import details dialogue box 

8. When importing data from an external source the above dialogue box 
appears.  The left-hand side contains the records being imported and the 
right hand side contains the field names for ztrAck’s enrolment data 
database.   

9. Check that the two sides are lined up correctly by scanning through the 
data. See page 14 for details on field types. You can do this by clicking 
and dragging the fields on the right so that they match the fields on the 
left. For a more detailed description of how to do this, consult the 
Filemaker Pro® manual if you have the network version or online help).  
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Generally the two sides will be lined up and you won’t have to make any 
changes.   

 
You can change the order of the fields in the student information database by  
1. Placing the cursor over the field name,  
2. Holding the mouse button down and  
3. Dragging the field to where you want it. 
 
Once the student info fields match up correctly with the data to be imported, 
click the import button. 
  
 
 

The Staff File  - Importing Staff Details from other software  

 
As with the student data, you need to populate your database with the details of 
your staff members. This can be done manually or by importing data from an 
admin database.   
 
 
 
 
 
 
 
 
To import staff data from an external source 

1. Export staff details from the timetable/enrolment software as tab 
separated text, call the file staff.tab and save it to a floppy disk. 

2. Go to the main menu 
3. Click on ‘Staff Files’ 
4. A delete current records message appears. Delete these records if you no 

longer require them. This will not delete the incident records only the 
student enrolment details. 

 
 
 
 
 
 

5. Choose the import option from the dialogue box below.  
• If you do not have student photos to import click DATA.  
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• If you have student photos and enrolment data choose BOTH. 

•  If you just wish to update photos choose PHOTOS. 
 
 
 
 
 
 
 

6. Click OK and Select the 
location of your 
enrolment data saved as a.tab or .csv file (on the storage media you 
saved the data to when you exported form your enrolment software e.g. 
CASES 21) – see  Extracting the student information data from CASES21 

 
 
 
 
 
 
 
 
 
 

 
7. Click Open 
 
8. Select the fields for import. 
9. Check that the two sides are lined up correctly by scanning through the 

data. See page 14 for details on field types. You can do this by clicking 
and dragging the fields on the right so that they match the fields on the 
left. For a more detailed description of how to do this, consult the 
Filemaker Pro® manual if you have the network version or online help).  
Generally the two sides will be lined up and you won’t have to make any 
changes.  See Import Field Mapping diagram on the next page. 
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10. Click Import. 
 

You can change the order of the fields in the student information database by  
1. Placing the cursor over the field name,  
2. Holding the mouse button down and  
3. Dragging the field to where you want it. 

 
Once the staff info fields match up correctly with the data to be imported, click 
the import button. 
 
Note:  the teacher codes in CASES or other enrolment/timetable packages often 
differ from the timetable initials actually used.   
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Adding New Student Incident Records 

Note: The example below uses a discipline record. The process is exactly the 
same for Welfare and Achievement records. 

 

 

How to create a new student record. 
1. From the site map click Incident Files 
2. Click ‘New Record’ 

 
 

 
 
 

3. Click in the ‘Enter Student Surname’ box.  
4. Type the student’s surname in the dialogue box and make sure you use 

the correct spelling. Click OK. 
5. Scroll down the list and select the red arrow next to the student for whom 

you are creating an incident record. 

 
 
 
 

6. You are now presented with a blank record containing the student’s 
details. Note: The date of the incident is inserted automatically as the 
current date. You can edit this field by clicking in the Incident date box 
and typing anew date. 
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Describing an incident 

7. Choose the time of day the incident occurred. You can edit this list to 
include different times by clicking Edit and entering new values or deleting 
values that are not required.  

 
 

8. Choose the incident category Discipline, Welfare or Achievement in 
the ‘Category’ box.  The field will default to Discipline. 

 

 
 

9. Choose the type of incident. This a further description based on the 
category chosen at step 8. You can add a new incident type by clicking on 
the red arrow at the right of the field. 

 
 

You can add a new incident type by going to Utilities > Incident Types. 
 

 
 

10.  Description of the incident should include any relevant details not 
included elsewhere. For example, Struck victim with a cricket bat, Wrote 
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obscenities on toilet door.  IMPORTANT:  The comments you type in this 
box will appear on form letters and in reports.  Make sure it is fit for 
parent, student and staff perusal. 

11.  Select a teacher.  The referring teacher is the teacher who witnessed 
or reported the incident. 

12.  Select a victim if it is relevant to the incident.  For example if you are 
creating a record for bullying or fighting you would specify a victim.  If 
there is more than one victim create a new record. 

13.   Choose a subject or location if relevant.  Note:  You can add to the 
list of locations by scrolling to the bottom of the location list and selecting 
‘edit’.  A dialogue box then appears, simply type your new category into 
the list.  Try to keep it the list in alphabetical order for easy reference. 

 
Choosing an appropriate Action Taken 
 

14.   Select a Response by choosing from the list.  The action comment is 
inserted automatically in the text box. 

 
 
Note: You can add new responses by clicking on the red arrow at the right of 
the Response box ‘Responses’ 
 

 
 

Type your new value in the existing list.  For 

example to add ‘Football Field’.  Click after the 
word ‘Excursion’ and type in Football Field. 
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15.  IMPORTANT:  Action comment number 1 refers to form letter 1 
when using the ‘Send Letter’ button.  The action comment is 
inserted automatically in the text box. If Detention is chosen then 
a detention letter will be generated after clicking the ‘Send Letter’ 
button. 

 
 
16.  Enter an ACTION DATE, this is the date that the Response will or did take 

place. 
 
IMPORTANT:  If the action is a detention then the action date is the date 
on which that detention is to occur. A dialogue bow appears when detention is 
selected as the response. You can fill in the time and location for the detention in 
this box. See Entering Detention Times and Location page 10 
 
 IMPORTANT:  If the action is a suspension then you must specify Action 
Date 1 and Action Date 2, the span of the detention See Specifying Suspension 
Dates page 12 

 
Duplicating/Batching Records  
 

If you have multiple offenders for the same incident it 
easier to use the Duplicate function to create their 

records. 
 
1. Create the first record and fill in all details of the incident(see page 20 – 

create a new discipline record) 
2. Click the ‘Duplicate’ button. Warning: Do not choose duplicate from the pull 

down menu. 
3. The details in the new record are the same as the previous record.  You just 

need to select a new student. 
4. Type in a surname and then SELECT the student from the list at right. 
 



 

 Page 25  

Form Letters  
 

Below is a list of form letters already in the database: 
 
1 - Detention Letter 
2 - General Letter 
3 - Suspension 
4 - Suspension Formal 
5 - Failure to Complete Set Work 
6 - Out of Uniform 
7 - Missed Detention 
8 - Out of Bounds 
9 - Time Out 
10 - Smoking 
11 - Sports Award 
12 - Class Work Award 
13 - Student of the Month 
14 - Cetificate1 
15- Class reward 
 
Once a record has been created you have the option of printing a form letter. 
The form letters correspond to the responses you specified when you created the 
record. IMPORTANT NOTE: not all Responses will have a related letter. 
 
You have two basic choices on the type of letter to send. 
O A general letter outlining the incident. Choose the Response General Letter 

when you create the record if you wish to send a general letter. 
O An incident specific letter.  For example, if the student was caught smoking 

the letter will be a pre-prepared letter on smoking and the course of action 
the school will take.  

 

How to send a form letter 
 
Choose the Send Letter  button once you have created a record. 
 

 
Creating your own Form Letters 
Creating your own form Letters requires a copy of Filemaker Pro  7 or later ® 
and knowledge of designing layouts.  Consult the manual or online help that 
came with your FM Pro 5 software.  Zenith Data can develop your form letters 
for you prior to receiving your Z Track database (at additional cost). 
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Password required to edit the form letters (multi-user 
version only). 
1. Close the program if it is open. 
2. Navigate to the folder where the program files are kept. 
3. Double click on the file called incident. 
4. Enter the password (call Zenith Data if you have don’t know your password). 
5. Click OK. 
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Incident Menu  

 

Finding  Student Incident Records 

 

 

     

 
Click on in any screen will bring up the Find dialogue. 

 

1. From the site map click ‘Incident Files’ 
2. A Dialogue box appears. 

 

 
 

3. Enter the details of the student you wish to find. Partial strings are allowed. 
i.e. the first three letters of the first name and surname. 

 
 
4.  Enter the student’s details.  For example if you enter the student’s 

surname and form you will get all of the students with that surname in the 
form specified.  If you enter first name and surname, you will get all of 
the students with that name. 
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Specifying dates for a student record search 

5. If you want to search for records between certain dates click the   
button and you can specify the dates by typing in the ‘Record Date’ box.  
Note: dates ranges must be in the format 1/11/2001…15/11/2001.  (Start 
and end dates should be separated by three dots).  The example above 
will find all of the records between the first and fifteenth of November 
2001. 

6. After completing your search you will be presented with a list of records 
matching your criteria (see below). To bring up the detail for a record click 
on the blue triangle at the left of each summary. 
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Using the features of the Incident Description Screen  
 

You can get instant snapshots of the database by using the various features on 
the main screen see below for a summary. See the number key below for details. 
 

 

 
 

1. Student photo. 
2. Dynamic incident chart. 
3. Easy navigation menus. 
4. Parent contact details. 
5. Point and click data entry describes the incident type. 
6. Location, associates of perpetrator and victim can all be recorded. 
7. Text boxes allow further description of incident and action taken. 
8. Chronological student contact history. 
9. Detailed record of school’s response to incidents. 
10. Detention management and form letter issue. 

2 

9 

1 
P

3 

1
0

8 

5 6 

7 

4 
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11. Printing a detailed incident history for the current 
student. 

 
 
 
 
 

 
 
 
 
 
 
 

1. Links to the reports menu where you can select from the following range 
of reports and charts: 
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List View and Detail View 

Toggles between a list (down arrow) view and full detail (up arrow) record view. 
 

 
 

How to find grouped data.   

For example, all of those students that have overdue work, or work due on a 
particular day. 
 
1. When in an incident record go to the pull down menu and select View>Find 

Mode (see below). 

 
 

2. Enter your search criteria. For example to find overdue work select the 
Category: Discipline and choose the incident Type: failure to complete set 
work. 

 
 

 
3. Click find in the left margin (or hit the enter key). 
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4. The found set now appears. You can switch to list view to see all records. See 

page 30 List View and Detail View or you can flip through the records by 
clicking on the notepad in the left margin. 

 

 
 

Searching for records by specific dates 

Use the same steps outlined in How to find grouped data and then specify the 
dates by typing in the ‘Record date’ box.  Note: dates ranges must be in the 
format 1/11/2001…15/11/2001.  (start and end dates should be separated by 
three dots).  The example above will find all of the records between the first and 
fifteenth of November 2001. 
 
 

 
 

Notepad – clicking on the 
right moves forward 
through the found set, 
clicking on the left page 
moves backwards. 
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Printing a Conduct Report for all students 
To print a report, click the  when you are in the Incident 
Description screen. This produces the report screen shown on 
page 29. 
 
 

Importing and Exporting Data 

The database supports all common data export formats.  Thus it is compatible 
with almost any spreadsheet or database application. Importing and exporting 
data into the database is a simple process. 
 

Importing Data into the database 
 

1. From the pull down menus select File > Import Records >File 
 

2. Select the file you wish to import.  
 
3. Match the fields you wish to import on the left, with those in the student 

database on the right.  See example in importing student records.  You can 
line the fields up with the import data by dragging the field names running 
down the right hand side of the box until they are aligned with the correct 
data.  Consult your FM pro  manual for further details in importing and 
exporting data. 

4. Click IMPORT and click OK for auto-enter options. 
 

Exporting Data from the database 
 

1. From the pull down menus select Export Record. 
 

2. Select the location you wish to export to. 
3.  Choose the format tab separated text .tab from the save as type menu.  
4. Name the file to be exported.  For example incident records.  
5. Click Save. 
6. Select Clear All  
7. Click on the first field you wish to export in the left-hand side of the box. 
8. Click Move 
9. Select a second field. 
10. Click Move. Continue this process until you have selected all of the fields you 

wish to export. 
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11. Click Export, the data is exported as tab separated text to the location you 
determined in step 10. 

NOTE:  You can move all fields in one go by selecting the Move All option. 

Statistical Reports 

A useful application of the software is generating statistical reports at any time 
on the categories shown below.  These figures can be exported into external 
spreadsheet and database applications for graphing or printed as they appear on 
the screen.  
   
 
 
 
 
 
 
To get a statistical report at any time: 
1. From the Main Menu click ‘Incident Files’ then select ‘Reports’  
2. Choose the statistical category you want (See below). 
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Filemaker Pro  Databases 

This manual is by no means comprehensive.  Other sources of information are 
shown below: 
� Filemaker Pro 7 or later manual. 
� www.zdata.com.au (Zenith Data web site) 
� www.filemaker.com.au 
� Filemaker Forums – try a Google ® search 
� Most good bookshops carry Filemaker Pro  7 or later ® ‘How To’ texts. 
 

 
© ZENITH DATA Data 2007 

Recovering damaged files 

Power failures, hardware problems, and other factors can damage a Filemaker 
Pro  file. If a file is damaged, you can use the Filemaker Pro  recovery feature. 
Filemaker Pro  attempts to repair and salvage as much of the information in the 
file as possible, and then creates a recovered file. You can open and use a 
recovered file just like any other Filemaker Pro  file. 
 
Important Before you begin, be sure you have enough disk space for the 
recovered file. If there isn’t enough space, the recovered file won’t be usable. 
 

To recover a damaged file (network version): 
 
1. Be sure the damaged file is closed. 
 
2. Choose Recover from the File menu. 
 
3. In the Open Damaged File dialog box, select the damaged file, and then 

click Open. 

 
In the Name Recovered File dialog box, Filemaker Pro  adds Recovered to the 
filename (which might be truncated). 
4. If you want to rename the file, for Name new recovered file, type a name. 
5. Click Save. 
 

A status message tells you about the recovery process. A second message 
reports the success of the recovery—how many bytes were salvaged, the 
number of records and values skipped, and the number of lost field definitions 
that were rebuilt. 
 
6. Click OK. 
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To recover a damaged file (runtime version): 
 
1. Be sure the damaged file is closed. 
 
2. On Windows machines, press Ctrl+Shift while double-clicking the 

runtime application icon.  Hold the keys down until you see the Recover 
File dialogue box.   

 
3. In the Open Damaged File dialog box, select the damaged file, and then 

click Open. 
 
In the Name Recovered File dialog box, Filemaker Pro  adds Recovered to the 
filename (which might be truncated). 
4. If you want to rename the file, for Name new recovered file, type a name. 
5. Click Save. 
 

A status message tells you about the recovery process. A second message 
reports the success of the recovery—how many bytes were salvaged, the 
number of records and values skipped, and the number of lost field definitions 
that were rebuilt. 
 
7. Click OK. 
 
During the recovery process, the Filemaker Pro runtime application: 
 

• creates a new file 
 

• renames any damaged file by adding Old to the end of the file names 
(for example, Contact Manager is renamed to Contact Manager Old). 

 
• gives the repaired file the original name 
 

If users experience unusual behavior in the recovered files, they should revert to 
a backup copy that was made before the file became  corrupt, or contact ZENITH 
DATA on (03)51455307 for technical assistance. 
 

 

When a file has been recovered: 
 

1. Recover the damaged solution file. 



 

 Page 37  

 
2.  Open the recovered solution file in the runtime application. 
 
3. Save a compressed copy—choose File menu> Save a Copy As. In the 

dialogue box, choose Compressed Copy (Smaller) from the Save As 
(Windows) or Type (MacOS ) pop-up menu, name the file, and click Save. 

4. Give the compressed file the same name as the original file name.  E.g if you 
recovered a file called discp then the compressed file should be saved as 
discp. 

 
 

Recovering files - keep these points in mind: 
 

• To ensure you always have a file that’s up to date, make frequent back up 
copies of your files, and don’t write over the most recent copies. 

• If a file is severely damaged, you might not be able to recover it. 
 

A file can grow or shrink in size. A file can grow if the indexes were damaged 
and repaired. A file can shrink when data deleted by the user, like a paragraph, 
has finally been deleted from the file. 

Sharing databases on a network 
Filemaker Pro 7 or later contains built-in support to allow you to share files over 
a network. By sharing files, you can work simultaneously with others in your 
work group, and save disk space by keeping files in a central location. Filemaker 
Pro supports sharing of up to 10 files with up to 10 concurrent users. In certain 
instances, you can share a single Filemaker Pro file with up to 25 other 
concurrent users, with this number dropping as you share more files. For greater 
networking performance and capacity, FileMaker, Inc. recommends the use of 
FileMaker Server if you need to share files with more than 10 concurrent users 
on a network.  
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